Fairbanks North Star Borough
Rural Roads Upgrade Inventory and Cost Estimation Software
User Guide: Version I

Prepared By:
Ming Lee, Ph.D
University of Alaska Fairbanks
April 2013

Prepared By:
Alaska University Transportation Center
Duckering Building Room 245
P.O. Box 755900
Fairbanks, AK 99775-5900

Fairbanks North Star Borough
PO Box 71267
Fairbanks, AK 99707-1267

INE/AUTC 13.10
**1. AGENCY USE ONLY (LEAVE BLANK)**

**2. REPORT DATE**
April 2013

**3. REPORT TYPE AND DATES COVERED**
Final Report (08/01/2009-07/31/2012)

**4. TITLE AND SUBTITLE**

**5. FUNDING NUMBERS**
AUTC#309020
DTRT06-G-0011

**6. AUTHOR(S)**
Ming Lee, PH.D, P.E.

**7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES)**
Alaska University Transportation Center
P.O. Box 755900
Fairbanks, AK 99775-5900

**8. PERFORMING ORGANIZATION REPORT NUMBER**
INE/AUTC 13.10

**9. SPONSORING/MONITORING AGENCY NAME(S) AND ADDRESS(ES)**
Research and Innovative Technology Administration (RITA) (USDOT)
1200 New Jersey Ave, SE, Washington DC 20590
Fairbanks North Star Borough
PO Box 71267, Fairbanks, AK 99707-1267

**10. SPONSORING/MONITORING AGENCY REPORT NUMBER**

**12a. DISTRIBUTION / AVAILABILITY STATEMENT**
No restrictions

**13. ABSTRACT (Maximum 200 words)**
The Rural Road Upgrade Inventory and Cost Estimation Software is designed by the AUTC research team to help the Fairbanks North Star Borough (FNSB) estimate the cost of upgrading rural roads located in the Borough's Service Areas. The Software performs two major functions: existing road condition inventory and upgrade cost estimation. Upgrade cost estimation requires road condition inventory data, thus it can only be performed after existing inventory data are entered. Estimation of upgrade cost also requires that material unit costs be specified and updated by the software users before the estimation can be performed.

**14. KEYWORDS:** Software, Low Volume Roads, Asset Management, Transportation System Management, Highway design.

**15. NUMBER OF PAGES**
62

**16. PRICE CODE**
N/A

**17. SECURITY CLASSIFICATION OF REPORT**
Unclassified

**18. SECURITY CLASSIFICATION OF THIS PAGE**
Unclassified

**19. SECURITY CLASSIFICATION OF ABSTRACT**
Unclassified

**20. LIMITATION OF ABSTRACT**
N/A

NSN 7540-01-280-5500

STANDARD FORM 298 (Rev. 2-98)
Prescribed by ANSI Std. 239-18 298-1
# Table of Contents

Summary ....................................................................................................................................................... 4

Introduction to the Rural Road Upgrade Software....................................................................................... 5

Upgrade Pavement Design and Cost Estimation Methodology ................................................................. 5

Rural Road Database ................................................................................................................................... 5

Road Segmentation ................................................................................................................................. 6

Basic Software Structure ........................................................................................................................... 7

Software Installation ................................................................................................................................... 10

User Interfaces ............................................................................................................................................ 15

File Menu Item ........................................................................................................................................ 15

All Road Table ......................................................................................................................................... 16

Sorting Records ................................................................................................................................... 17

Variables .............................................................................................................................................. 17

Road Data Form ...................................................................................................................................... 19

Edit Menu Item ....................................................................................................................................... 23

Context Menu (Right Mouse Button Menu) ............................................................................................ 26

Unit Cost Menu Item ............................................................................................................................... 27

FNSB Map Window ................................................................................................................................ 29

Map Menu Item ................................................................................................................................... 30

View Menu Item ................................................................................................................................... 31

Help Menu Item ................................................................................................................................... 31

Road Inventory Data Entry Example ....................................................................................................... 33

Working with the Service Area Roads Data Table .................................................................................. 35

Working with the Individual Road Data Form ........................................................................................ 37

Updating Total Length ............................................................................................................................ 37

Entering Road Inventory Data ................................................................................................................ 42

Entering Road Height and Road Width ...................................................................................................... 43

Working with the FNSB Map .................................................................................................................. 47

Zoom In and Zoom Out ........................................................................................................................... 47

Pan and Identify ...................................................................................................................................... 48
Summary

This guide provides user interface descriptions and introductory tasks of the Rural Roads Upgrade Inventory and Cost Estimation Software, developed for the Fairbanks North Star Borough. It describes how to use the software for entering rural road inventory data and subsequently performing upgrade cost estimation.

The User Guide contains the following sections:

1. Introduction to the Software
2. Software Installation
3. Software User Interfaces
4. Road Inventory Data Entry Example
5. Unit Cost Entry
6. Upgrade Cost Estimation Example
7. Road Upgrade and Cost Estimation Methodology
8. Appendix

The first two sections give users an overview of the software and guide users through the installation process. The third sections provide descriptions of the user interfaces of the software. With an general understanding of the user interfaces, users can work on an data entry example in section 4 and complete cost estimation for the same example in section 5 and 6. The last section documents the methodology used by the software for pavement design and cost estimation. More details of the methodology is provided in the Appendix.
Introduction to the Rural Road Upgrade Software

The Rural Road Upgrade Inventory and Cost Estimation Software is designed by the AUTC research team to help the Fairbanks North Star Borough (FNSB) estimate the cost of upgrading rural roads located in the Borough's Service Areas. The Software performs two major functions: existing road condition inventory and upgrade cost estimation. Upgrade cost estimation requires road condition inventory data, thus it can only be performed after existing inventory data are entered. Estimation of upgrade cost also requires that material unit costs be specified and updated by the software users before the estimation can be performed.

Upgrade Pavement Design and Cost Estimation Methodology

The estimation of upgrade cost is based on the pavement design method documented in *Gravel Road Upgrade Pavement Design Module*, written by Robert L. McHattie of the AUTC research team. This pavement design method is based on the Excess Fines pavement design method used by the Alaska Department of Transportation and Public Facilities (AKDOT & PF). The document is included as an appendix at the end of this User Guide.

Rural Road Database

The software manages a database of all rural roads located within the Service Areas, excluding roads maintained by the AKDOT & PF, the City of Fairbanks, and the City of North Pole (Figure 1). The database is derived from FNSB’s GIS Road Centerlines Shapefiles. This database is referred to as the Service Area Roads (SAR) database throughout this user guide.
Figure 1 Rural Roads Included in the Software Database

Road Segmentation

Generally, segments of roads with the same name are represented as one individual link in the SAR database. For example, the Spring Glade Road in the Spring Glade Service Area (Figure 2) is represented in the database as a link with two 90 degree curves. There are a few exceptions to this rule. For example, when a road runs across two service areas, the road is divided into two segments, one in each service areas. Also, loop roads that run in circle may also be divided into two segments to help distinguish the beginning and the end of the roads.
Basic Software Structure
For the management of Service Area Roads database, the Rural Road Upgrade software contains two graphical user interfaces: a spreadsheet table called All Road Table (see Figure 3) in which each road segment listed as a record, and a GIS map called FNSB Map that is used to pinpoint the location of a particular road in the database. Clicking at the road name of each individual road segment in the spreadsheet table activates an individual data form for the road
clicked. The data form is used to store road inventory data and perform upgrade cost estimation. Figure 3 shows how the software operates.

**Figure 3 Basic Software Structure**

In the center of Figure 3, the All Road Table retrieves and saves data to the XML format of the SAR database *(SAR Database.xml)*. The SAR database stores summary data for all the roads such as names, length, field survey date, soil sample date, foundation cost, pavement construction cost, and total cost.

For each road segment shown in the All road Table, an individual XML data form can be activated for data entry and cost estimation by clicking at the road name hyperlink. Once users finish entering data and estimating cost for the road, the road XML form can be saved as an individual XML file with a file name identified by the concatenation of Service Area-Road Name-Segment Number *(Herning Hills-Herning Rd-2.xml)*. The entered inventory data and cost estimates will be written to the SAR database.
The FNSB map on the left hand side is served by GIS shape files. Each road segment in the SAR database has a geographical representation in the GIS map that is identified by an identical ID number in both the SAR Database and the GIS shape files.

Updating of the road data is accomplished for each individual road with the Road Data Form. After data entry or update is completed, the changes are first saved to the road's XML file, followed by an update in the SAR XML file. Finally, the change will also be saved to the GIS shape files such that the updated data and cost can be displayed in the map.
Software Installation

Included with this User Guide is a DVD that contains the setup files for the trial version of FNSB Road Upgrade software.

To install the software, simply run the setup.exe file by double clicking at the file in Windows Explorer. The Setup Wizard will appear to guide you through the setup process (Figure 4).

![FNSB Road Upgrade Software Setup Wizard](image)

Figure 4 FNSB Road Upgrade Software Setup Wizard

After clicking next, the second dialog box asks you to specify the directory where the software is to be installed (Figure 5).
After determining the directory to install the software, clicking "Next" will begin the installation process. When it is done, you will be notified that the installation is finished and a shortcut icon is placed on the computer desktop.

Before you can run the program, depending on the security setup of your computer, you may need to make two data folders under the program directory available to all users:

- `C:\Program Files (x86)\AUTC\FNSB Road Upgrade\Data`
- `C:\Program Files (x86)\AUTC\FNSB Road Upgrade\MapData`

To do this, in Windows Explorer, find the two folders and use the right mouse button to access the Properties page of the folder (Figure 6).
Figure 6 Accessing Data Folder Properties

When the Properties page of the Data folder appears, first uncheck the Read-only attributes (Figure 7), because the software will read and write to files in this folder.
Next, go to the Security tab of the properties page. Make sure the user of the software have full control of the folder (Figure 8). If not, use the Edit button to assign full control to the intended user.
Repeat the same process for the MapData folder. Once the intended user has full control of the two folders, the program can be launched by clicking at the desktop shortcut icon.
User Interfaces

After launching, the software's main interface is shown in Figure 9. The interface includes six menu items: File, Edit, Unit Cost, Map, View, and Help. The icons on the Tool Bar can be clicked to access particular functions of the Menu items. The icons, from left to right, are: Open, Save, Print, Copy, Paste, Add Rows, Delete Rows, Zoom In, Zoom Out, Full Scale, and Identify.

Figure 9 Software Main Interface

File Menu Item

The pull down list underneath the File Menu Item is shown in Figure 10.
The File menu items perform the following functions:

- **Open**: Open user interfaces for data entry
  - Data Table: Opens the All Road Table
  - Map: Open the FNSB Map
- **Close**: Close an active interface window
- **Save**: Save the data entered into the Road Data Form. Data in the All Road Table are automatically saved.
- **Save As Excel**: The data in each Road Data form and the All Road Data can be saved as Excel files. When either the Road Data form or the All Road Data window is the active window, clicking at the Save As Excel will save the data in the active window as an Excel file whose directory and filename can be chosen by the users.
- **Print**: Print the data in a Road Data Form or the All Road Table when it is opened. Note that data in the All Road Table should only be printed for the records with survey data entered, because there are over 2,000 road segments included in the database and many of them have no data. To identify road segments with data, first sort records by the Survey Date such that the records with data are on top, then print only the first few pages that have data.

**All Road Table**
Clicking on the Data Table will open the All Road Table. The interface of the All Road Table is shown in Figure 11. This table contains all the road segments in FNSB’s Service Areas. Each
road segment, identified by Service Area name, Road name, and Segment number, in the SAR Database has one record in the table.

The All Road Table is used to manage road upgrading costs estimated by the software. Data in the All Road Table are protected and users can not manually change the data in the table. Changes to the data are made by the specially designed hyperlinks in the table. The **Road Name** hyperlink facilitates inventory data entry for a segment. The **Survey Date** hyperlink lets users delete previously entered data.

**Sorting Records**

When the All Road Table first appears, all the records are sorted by the ID number. The sequence of the ID numbers are established in alphabetic order first by Service Area then by Road Name. Records in the All Road Table can be sorted by clicking at each diamond sign in the column heading of a field. First click will sort the records in the ascending order of the field clicked. Second click reverses the order.

To restore the original order, simply sort by the ID number.

![Figure 11 All Road Table Interface](image)

**Variables**

The All Road Table contains 13 variables. The variables in this table and their definitions are shown in Table 1.

**Table 1 All Road Table Variable Definitions**
<table>
<thead>
<tr>
<th>Variables</th>
<th>Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Identification number of a road segment</td>
</tr>
<tr>
<td>Service Area</td>
<td>Name of the Service Area for the road segment</td>
</tr>
<tr>
<td><strong>Road Name</strong></td>
<td>Name of the road segment. A hyperlink to activate the Road Data form for the segment.</td>
</tr>
<tr>
<td>Segment</td>
<td>Number of the road segment</td>
</tr>
<tr>
<td>Length</td>
<td>Road length in feet</td>
</tr>
<tr>
<td><strong>Survey Date</strong></td>
<td>Date when the survey take place (copied from Road Data form). A hyperlink to delete previously entered data of the segment.</td>
</tr>
<tr>
<td>Foundation Cost</td>
<td>Cost required to improve foundation and drainage for pavement (copied from Road Data form)</td>
</tr>
<tr>
<td>Sample Date</td>
<td>Date when soil sampling take place (copied from Road Data form)</td>
</tr>
<tr>
<td>Base Course Cost</td>
<td>Estimated cost for base course materials required for pavement (copied from Road Data form)</td>
</tr>
<tr>
<td>SCF Cost</td>
<td>Estimated cost for Standard Cover Fill materials required for pavement (copied from Road Data form)</td>
</tr>
<tr>
<td>Pavement Cost</td>
<td>Estimated cost for materials required for pavement (copied from Road Data form)</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Total cost including foundation, base course, SCF, and pavement costs</td>
</tr>
<tr>
<td><strong>MapLink</strong></td>
<td>A hyperlink that actives the FNSB map and points to the road segment in the map</td>
</tr>
</tbody>
</table>

The field Length contain the length of the road segment in feet. The length of a road segment is estimated according to the corresponding record in FNSB's Road Centerlines GIS database. It is likely that the estimated length is longer or shorter than the actual length in the field. Once the survey takes place, users can change the length using the Road Data Form.

Three variables in the table are formatted as hyperlinks: **Road Name**, **Survey Date**, and **MapLink**. Clicking on each link performs a different function.

- **Road Name**: Opens the Road Data Form for the road segment clicked
- **Survey Date**: Once the survey data are entered and saved into a Road Data Form, the entered survey date will be copied and pasted in this field. If users made a mistake and wants to delete the previously entered Road Data Form of a particular segment, double clicking the **Survey Date** hyperlink will prompt the users to confirm the deletion. The form will be permanently deleted if users answer Yes to the deletion confirmation.
- **MapLink**: The hyperlink **MapLink** is created after the Road Data Form has been saved. The link, when double clicked, opens the FNSB Map (if not already opened) and zoom in to the clicked road in the center of the map window.
Road Data Form

For a road whose inventory data have not been entered and saved before (i.e., the Survey Date cell is empty), clicking at the Road Name of the segment in the All Road table activates a new Road Data form. The Road Data Form contains two major portions: the road inventory on the left hand side of the form (Figure 12) and pavement cost estimation on the right hand side of the form (Figure 13).

Figure 12 Road Inventory Data Portion of a Road Data Form
The cells highlighted in yellow are cells that need to be entered by the users and the cells in blue are filled out by the software. Users should not manually alter values in the blue cells.

For the purposes of pavement design and cost estimation, the entire road segment is divided into multiple 50 ft sections with exception of the last section that is usually less than 50 ft. All the data cells in Row 1 to 11 are variables pertaining to the entire road segment as identified by the road name and segment number. Row 12 is the headings for road conditions and dimensions that are to be entered for each 50 ft section. Beginning from Row 13, each row is to be filled out for each 50 ft section.

The variable definitions of a Road Data Form are shown in Table 2.

**Table 2 Road Data Form Variable Definitions**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Definitions</th>
<th>Applied to Entire Road Segment or 50-ft section</th>
<th>User-entered or Software-Generated</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Road Inventory Variables</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Road Name</td>
<td>Road Name (copied from the All Road Table)</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>Segment</td>
<td>Segment number (copied from the All Road Table)</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>Service Area</td>
<td>Service area name (copied from the All</td>
<td>Entire road</td>
<td>Software</td>
</tr>
<tr>
<td><strong>Road Table)</strong></td>
<td><strong>Road ID</strong></td>
<td><strong>Survey Date</strong></td>
<td><strong>Survey Time</strong></td>
</tr>
<tr>
<td>----------------</td>
<td>------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>Road ID (copied from the All Road Table)</td>
<td>Survey date</td>
<td>Survey time</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
<td>Unit</td>
<td>Source</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>------------</td>
</tr>
<tr>
<td>With Pond</td>
<td>Total segment length checked with YES for ponding adjacent to road</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>Drain Need Maint.</td>
<td>Total segment length checked with YES for drainage need maintenance</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>Crown Not Accept</td>
<td>Total segment length checked with NO for crown and superelevation acceptability</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>Soft Area</td>
<td>Total segment length checked with YES for soft area</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td><strong>Pavement Design Variables</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design Width</td>
<td>Design width of the upgraded road</td>
<td>Entire road segment</td>
<td>User</td>
</tr>
<tr>
<td>Side Slope</td>
<td>Design side slope of the upgraded road</td>
<td>Entire road segment</td>
<td>User</td>
</tr>
<tr>
<td>Add Base Course</td>
<td>Add base course or not for the upgraded road (Yes, No)</td>
<td>Entire road segment</td>
<td>User</td>
</tr>
<tr>
<td>Pavement Width</td>
<td>Design width of the pavement</td>
<td>Entire road segment</td>
<td>User</td>
</tr>
<tr>
<td>Pavement Options</td>
<td>Options for pavement materials and thickness</td>
<td>Entire road segment</td>
<td>User</td>
</tr>
<tr>
<td>Sample Loc</td>
<td>Soil sampling location (mark location w/ sample code #)</td>
<td>50-ft section</td>
<td>User</td>
</tr>
<tr>
<td>SP200</td>
<td>Surface soil sample P200 value</td>
<td>50-ft section</td>
<td>User</td>
</tr>
<tr>
<td>SSP200</td>
<td>Sub Surface soil sample P200 value</td>
<td>50-ft section</td>
<td>User</td>
</tr>
<tr>
<td>EP200</td>
<td>Embankment soil sample P200 value</td>
<td>50-ft section</td>
<td>User</td>
</tr>
<tr>
<td>Base Course</td>
<td>Calculated Base Course depth</td>
<td>50-ft section</td>
<td>Software</td>
</tr>
<tr>
<td>SCF</td>
<td>Calculated Standard Cover Fill depth</td>
<td>50-ft section</td>
<td>Software</td>
</tr>
<tr>
<td><strong>Estimated Cost Variables</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Foundation Cost</td>
<td>Estimated cost for fixing foundation problems and improve drainage</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>Base Course Cost</td>
<td>Estimated base course material cost</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>SCF Cost</td>
<td>Estimated Standard Cover Fill material cost</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>Pavement Cost</td>
<td>Estimated pavement material cost</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Estimated total cost (the sum of all costs)</td>
<td>Entire road segment</td>
<td>Software</td>
</tr>
</tbody>
</table>

For each of the existing road conditions that is answered with a YES or NO (e.g., foundation problems and drainage acceptability), the default choice indicates good condition. For example, the default choice is NO for foundation problems, and YES for drainage acceptability. When users select the opposite of the default choice, the cell background will turn yellow and the corresponding total length field for that particular variable will begin to add up. Figure 14
shows that two 50 ft segments are checked for YES for foundation problems and the Length of Bad Foundation is showing 100 ft.

Figure 14 Filling Out Existing Road Conditions

Edit Menu Item

The Edit Menu Item contains functions that are only available for the Road Data Form (Editing is not permitted for the All Road Form). The functions of the Edit menu are similar to those in typical spreadsheet program. The pull down list underneath the Edit Menu Item is shown in Figure 10.
The Edit menu items perform the following functions:

- **Undo**: Undo the previous data entry step
- **Redo**: Redo the step that was previously undone
- **Copy**: Copy data in a cell or a range of cells onto Windows Clipboard.
- **Paste**: Paste the contents that were copied to the Clipboard to the location of the cursor
- **Add Rows**: Add rows to the Road Data Form. This function is for users to add more 50 ft sections to the Road Data Form when the actual length of the segment measured in the field is longer than the original total length estimated with the GIS database.

To add one row at the end of the form, click at the heading of the row where the row is to be inserted (multiple rows can be selected and added by holding down the Shift key while clicking at multiple row headings). Go to Edit/Add Rows and a new row will be created. Type in a number in the Segment length cell and the Distance and Total Length will be automatically calculated. See Figure 16, Figure 17, and Figure 18 for the sequence of screenshots that show how to add a row.

An example is given at the Data Entry Example to show how to adjust the discrepancy between field-measured length and the original GIS-estimated length.
Figure 16 Highlighting a Row to Add
Delete Rows: Delete 50 ft section rows from Road Data Form. This function is the opposite of Add Rows. It is used when the actual length of the segment measured in the field is shorter than the original total length estimated with the GIS database.

Too delete rows at the end of the form, click at the heading of the row where the row is to be deleted (holding down the Shift key while clicking at multiple row headings). Go to Edit/Delete Rows and the selected rows will be deleted. Adjust the segment length of the last row and the total length of the row will be automatically adjusted.

Clear: Clear the content of the selected cell or range of cells without placing them onto the Clipboard.
Five of the functions of the Edit Menu Item can be accessed through the Context Menu (Figure 19), which is activated by clicking at the Right Mouse button when the cursor is placed in a cell in the Road Data form.

![Figure 19 Context Menu (Right Mouse Button Menu)](image)

**Unit Cost Menu Item**

When the Road Upgrade program is launch, a set of unit cost variables is loaded with the program. When cost estimation is performed in the Road Data form, these unit costs are applied to the estimated material quantities to arrive at estimated costs for various parts of the pavement construction. The unit cost data are saved in the file unit cost.xml in the Data folder of the program directory.

Users can view and update the unit costs by going to the menu item Unit Cost/Update Unit Cost (Figure 20). The ensuring Unit Cost Data window is shown in Figure 21.
To update the unit costs, simply change the numbers and click at the Save button. If no change is to be made, click Cancel will close the window without changing the previously saved values. The unit cost can be printed out by clicking the Print button to activate the standard Windows Print Dialog box for printer selection and printing confirmation.
FNSB Map Window

The FNSB Map is for users to identify the location of a particular road. The window can be activated by going to File/Open/Map. If the data for a particular road is already entered in the All Road Table, users can also open the Map window by clicking at the MapLink hyperlink of the road in the All Road Table.

When the FNSB Map is opened through File/Open/Map, the initial map scale shows the entire area covered by roads in the FNSB boundary (Figure 22).

![FNSB Map](image)

**Figure 22 FNSB Map Window**

With the Full Scale view, the map is labeled with service area (i.e., light green boundaries) names. The green lines are mostly roads maintained by AK DOT & PF. The blue lines are roads located within service areas. These blue lines and the road names will show up as you zoom in closer. When the survey data are entered and saved in the database, the link for the road will be displayed in the color red.

Navigating the map is achieved through the Map menu item. The functions of the Map menu item can also be conveniently accessed with the corresponding icons in the program Tool Bar.
Map Menu Item
The Map menu item (Figure 23) contains program functions that are dedicated to the Map window.

Figure 23 FNSB Map Window

The functions of the Map Menu Items include:

- **Zoom In**: Zoom in the map at a constant scale each time the users click at it.
- **Zoom Out**: Zoom out the map at a constant scale each time the users click at it.

  If the computer mouse used to run the program has a middle wheel, the wheel can be used to control zoom in and zoom out of the map. Scrolling the wheel forward zooms in the map, backward zoom out.

- **Full Scale**: Return the map to the original full scale.
- **Pan/Identify**: Toggle between the Pan and Identify functions. When the mouse cursor is placed on top of the map, the default cursor is in the shape of a hand with the index finger 🖐️. If you want to pan the map to a different area, click the cursor at the map.
and drag the map to the desired area. The map center will move according to your pan direction.

Going to Menu item Map/Pan/Identify (or clicking at the Identify tool icon or) will turn the cursor to an arrow . When you place the arrow on top of a blue line and click at it, the All_Road_Table will open and the record for the road that you just click will be in the top row and highlighted. Note that the Identify tool icon shows a square around the arrow when the Identify function is on. The square disappears when the pan function is on.

**View Menu Item**

When multiple windows are open within the software's main interface, they can be arranged by the functions in the View menu item (Figure 24). The functions, Tile Vertical, Tile Horizontal, Cascade, work in the same way as typical programs running in Microsoft Windows operating system.

![Figure 24 View Menu Item](image)

**Help Menu Item**

Materials in this User Guide are formatted and compiled into a Windows Help system file. Clicking at the Content of the Help menu item (Figure 25) opens the standard windows help file.
Figure 25 Help Menu Item
Road Inventory Data Entry Example

An example is given here to show the users how to use the graphical user interfaces to enter inventory data into the software database.

In the summer of 2011, FNSB hired interns to inventory the existing road conditions. The data were written down on paper forms in the field and later entered into Excel Spreadsheets. Table 3 shows the inventory form for the Duckhawk Drive in the Chena Hills Service Area. The following example will show the users how to enter the inventory data for the Duckhawk Drive.
Table 3 Road Inventory Field Data Sheet

<table>
<thead>
<tr>
<th>Distance this Sheet (mile)</th>
<th>Optional Distance this Sheet (feet)</th>
<th>Significant Foundation Problems (yes, no)</th>
<th>Drainage Acceptability (yes, no)</th>
<th>Ponding Adjacent to Road (yes, no)</th>
<th>Drainage Maintenance Needed (yes, no)</th>
<th>Crown &amp; Superelevation Acceptability (yes, no)</th>
<th>Soft Area (yes, no)</th>
<th>** Natural Ground to Road Surface (height on minimum side, feet)</th>
<th>Road Surface Width (feet)</th>
<th>Photo Location (mark location w/ photo code # &amp; view-direction arrow)</th>
<th>Sample Location (mark location w/ sample code #)</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>0</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>0.5</td>
<td>80</td>
<td>Fox E-1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.01</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>24.5</td>
<td>Potholing (PH)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.02</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>23.5</td>
<td>PH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.03</td>
<td>150</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>22</td>
<td>PH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.04</td>
<td>200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>23</td>
<td>PH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.05</td>
<td>250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>22.5</td>
<td>PH + Washboarding (WB)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.06</td>
<td>300</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.5</td>
<td>21</td>
<td>11:12 (S)</td>
<td>PH + Washboarding (WB)</td>
<td></td>
</tr>
<tr>
<td>0.07</td>
<td>350</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.5</td>
<td>20.5</td>
<td>PH + WB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.08</td>
<td>400</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.5</td>
<td>22.5</td>
<td>PH + WB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.09</td>
<td>450</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.5</td>
<td>22.5</td>
<td>PH + WB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.10</td>
<td>500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.5</td>
<td>22.5</td>
<td>PH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.11</td>
<td>550</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.5</td>
<td>21</td>
<td>PH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.12</td>
<td>600</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>20.5</td>
<td>PH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.13</td>
<td>650</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2.5</td>
<td>20.5</td>
<td>PH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.14</td>
<td>700</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2.5</td>
<td>19.5</td>
<td>WB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.15</td>
<td>750</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3.5</td>
<td>21</td>
<td>WB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.16</td>
<td>800</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>N</td>
<td>3.5</td>
<td>22</td>
<td>Paved</td>
<td></td>
</tr>
<tr>
<td>0.17</td>
<td>837</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3.5</td>
<td>46</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To enter or update inventory data for a road, the record for the road will need to be identified in the database such that the road inventory form can be activated for data entry. There are two ways to locate the database record for the road. The first is to open the SAR database table, find the road record in the spreadsheet, and click at the road name hyperlink. The second is to use the map to identify the road and click at the road to access the data entry form for the road.

**Working with the Service Area Roads Data Table**

To access the road record via the spreadsheet view, go to **File/Open/Data Table** (Figure 26).

![Figure 26 Open the Road Database Table](image)

When the windows form **All_Road_Table** (i.e., table showing all Service Area roads) appears, scroll down until you find the Service Area **CHENA HILLS** and Road Name **DUCKHAWK DR** (Figure 27). Note that **All_Road_Table** is sorted in alphabetic order firstly by Service Area, secondly by
Road Name, and lastly by segment number. Also note that for a new entry, the Survey Date column will be blank with no data. The data record for a road whose data had been entered before will show a valid surveyed date as entered by the user last time the record was accessed.

![Image of All Road Table Showing All Service Area Roads]

**Figure 27 All Road Table Showing All Service Area Roads**

Double clicking at the Road Name **DUCKHAWK DR** will create the Road Data form (Figure 28) for users to enter inventory data of Duckhawk Dr. The Road Data form is designed with the basis of the field data form shown in Table 3. The upper half of the form corresponds to data specific to the road and the characteristics of the field survey, while the lower half consists of multiple data rows, each designed to store road condition data for every 50 feet of the road.
Figure 28 Road Data Form for Duckhawk Drive

Working with the Individual Road Data Form
In the Road Data form for the Duckhawk Drive, the cells colored in yellow are cells that need to be entered with road inventory data from field survey (see Table 3). If users want to save the entered data, the Survey Date cell cannot be left blank, because the survey date is to be used by the software as a flag to distinguish surveyed from un-surveyed roads.

The cells that are colored in blue are created by the software. The blue cells are designed to show database values (e.g., service area and road names) and calculation results. Users should not manually change the numbers in the blue cells.

Updating Total Length
Before beginning to enter data, users should note that the Total Length of the road in color blue is filled by the software based on the length calculated from the original FNSB GIS Centerlines database. This number is in reality a rough estimate of the actual road length. It can be either longer or shorter than the distance measured in the field. For example, the GIS estimated length for the Duckhawk drive is 856 feet, but the distance measured in the field is only 837 feet.
To make the correction in total length, users need to first delete the last row (i.e., segment length 6 ft) from the table then change the length of the last 50 ft segment from 50 ft to 37 ft.

To delete the last row, click at the row heading to highlight the row, then go to **Edit/Delete/Rows** (Figure 29). Note that if necessary multiple rows can be selected for deletion by pressing down the Shift key while clicking at the headings of the rows to be deleted. Selection of multiple rows only work for consecutive rows.

![Figure 29 Highlighting a Row for Deletion](image)

After clicking yes to confirm the deletion in the ensuring dialog box, the row will be deleted. Users should notice that the Total Length and the cumulative distance (i.e., the last number in the Distance column) have both been updated to 850 ft (Figure 30).
The last step in correcting the total length to 837 ft is to change the last segment length from 50 ft to 37 ft. Users should now note that both the Total Length and the cumulative length are both changed to the correct number 837 ft (Figure 31).
Figure 31 Changing the Segment Length of the Last Segment

In the event that the estimated road length is actually shorter than the field measured distance, additional rows are needed to correct the total length. The procedure to make the correction is similar to the example given above, except that new rows are to be added.

For example, if we are to change the Total Length from 837 ft to 856 ft, we need to first change the segment length of the last row from 37 ft to 50 ft, which will change the total length to 850 ft. Then, place the mouse cursor in a cell that is on the row to be added and go to Edit/Add/Rows (Figure 32).
In the newly created row, enter 6 in the cell for the segment length. You should notice that the Total Length and the cumulative distance are updated to 856 ft (Figure 33).
Entering Road Inventory Data
Beginning from Row 22 on an individual Road Data form, each row is designed to record the existing road conditions for every 50 feet of the road (except for the last segment which will often be less than 50 feet). Existing conditions related to the structure and surface of the road (e.g., the existence of significant foundation problems and the acceptability of drainage) are entered with Yes or No radio buttons.

When the Road Data form is loaded for the first time, the default choice for each Yes and No question is set for the favorable option for upgrading. For example, the default choice for Significant Foundation Problem is No and Drainage Acceptability Yes. When users enter an option that is unfavorable for upgrading (e.g., Yes on Foundation Problems and No for Drainage Acceptability), the selected cells will be highlighted in yellow and the summary numbers (in color blue) in Row 10 will show the total length of the road that has a particular unfavorable condition. For example, the field survey rater indicated that the Duckhawk Drive needs drainage maintenance for its entire 837 ft length and has soft areas from the beginning until 800 feet. Figure 34 shows the form when a user finish checking the condition questions for the Duckhawk Drive.
Entering Road Height and Road Width

The Road Height and Road Width columns need to be entered for every 50 ft segment surveyed, because these two variables are needed for pavement design and cost estimation. However, if upgrading is only considered for a portion of a lengthy road for a particular fiscal year, field survey can still be carried out for that portion of road. Users will then enter data for the surveyed length and leave rest of the rows empty. The program is designed to stop calculation at the row where the Road Width is left empty. The total upgrading cost reported by the software will be the total cost for the partial length (i.e., the segments with no road width entry will not be considered). More details on cost estimation are covered in a Cost Estimation section of this user guide.

Figure 36 shows the completed Road Data form for the Duckhawk Drive. To save the entered data, simply go to File/Save. If you do not go to File/Save, the Road Data form will remain unsaved and when you close the Road Data form (by clicking at the "X" button on the upper
right corner), you will be asked if you want to save the data by the Save Data prompt (Figure 35). Note that if you had saved the latest changes, the Save Data prompt will not come up.

![Save Data Prompt](figure35.png)

**Figure 35 Save Data Prompt**

Once the file is saved, you can close the Road Data form and the program will go back to the SAR All_Road_Table (Figure 37). You will notice that the Survey Date is now filled with the date that was entered on the Road Data Form. The software has also created a hyperlink [LinkToMap](#) for you to locate the Duckhawk Drive on the map. If you want to see the geographical location of the Duckhawk Drive, double clicking at the [LinkToMap](#) will open the FNSB Map centered on the Duckhawk Drive (Figure 38).
Figure 36 Completed Road Data Form for the Duckhawk Drive

![Completed Road Data Form for the Duckhawk Drive](image)

Figure 37 Updated Service Area Roads Table

![Updated Service Area Roads Table](image)

Figure 38 FNSB Map Centered on the Duckhawk Drive

![FNSB Map Centered on the Duckhawk Drive](image)
It is mentioned previously that the FNSB Map can also be used to find a particular road to activate the Road Data form. You can now see how this works. While the FNSB Map is still showing the Duckhawk Drive, move your mouse cursor on top of the Duckhawk Drive and click at it. You should see that the All_Road_Table is brought to the front and the record for Duckhawk Drive is shown on the first row and highlighted (Figure 39). If you want to edit the Duckhawk Drive again, you can click at the hyperlink DUCKHAWK DR to open the Road Data form.

![Figure 39 All Road Table Returning from FNSB Map with Duckhawk Dr Highlighted](image)

Once you finish examining the map, close the FNSB Map window by clicking at the "X" button on the upper right corner of the Map window. The All_Road_Table window is now the active window (i.e., the color of the title bar of the window is highlighted). Because the All_Road_Table has been updated, if you want to save the change, go to File/Save. The change will be saved to the database. If you don't want to save the change, when you close the All_Road_Table window, simply click No on the Save Data prompt.

Once you have saved the data, close the All_Road_Table window by clicking at the "X" button on the upper right corner of the Map window.
Working with the FNSB Map

The next example shows how to work with the FNSB Map to find a road for data entry and cost estimation.

Close all open windows if there is any. Go to File/Open/Map. The FNSB Map shows up with a full scale view of all the roads in the FNSB boundary (Figure 40).

![FNSB Map](image)

**Figure 40 FNSB Map Full Scale**

With the Full Scale view, the map is labeled with service area (i.e., light green boundaries) names. The green lines are mostly roads maintained by AK DOT & PF. The blue lines are roads located within service areas. These blue lines and the road names will show up as you zoom in closer.

**Zoom In and Zoom Out**

Navigating around the FNSB Map can be accomplished with a mouse pointer that has a middle wheel. Scrolling the mouse wheel forward will zoom in the map, and scrolling backward zoom out. If your mouse doesn't have a middle wheel, clicking at the zoom in 📍 and zoom out 📍.
icons steadily zooms in and out of the map with each click. Clicking at the full scale icon returns the map back to the full scale.

**Pan and Identify**
When the mouse cursor is placed on top of the map, the cursor is in the shape of a hand with the index finger. If you want to pan the map to a different area, click the finger at the map and drag the map to the desired area. The map center will move according to your pan direction.

Clicking at the Identify tool icon or going to Map/Identify will turn the cursor to an arrow. When you place the arrow on top of a blue line and click at it, the All_Road_Table will open and the record for the road that you just click will be in the top row and highlighted (see Figure 39 for the Duckhawk Dr example).

**Access the Data Record of a Road**
Zoom in and pan to the Chena Hills service area to find the Duckhawk Drive. You should notice that the label for the roads will show up as you zoom in closer (Figure 41).
Figure 41 The FNSB Map Zoomed In to Duckhawk Drive, Chena Hills Service Area

Move your mouse cursor on top of the Duckhawk Drive and click at it. The All_Road_Table window will open and the record for Duckhawk Drive is shown on the first row and highlighted in the same way that is shown in Figure 39. If you want to edit the Duckhawk Drive, you can click at the hyperlink DUCKHAWK DR to open the Road Data form.
Unit Cost Entry

Unit costs for foundation improvement and pavement materials are used by the Software for the estimation of upgrade cost. When the software is launched for the first time, a set of default unit costs is loaded and saved in the file unit cost.xml located in the program data folder. The unit cost in the unit cost.xml file can be updated by going to Unit Cost/Update Unit Cost to open the Unit Cost Data form (Figure 42).

![Unit Cost Data](image)

Figure 42 Unit Cost Data

To update unit costs, simply change the unit cost numbers and press the Save button. Pressing the Cancel button exits the form without saving. The Print button produces a printout of the unit costs to the printer.
Cost Estimation Example

We continue the Duckhawk Drive example here to show you how to use the software to estimate upgrade cost. Note that because sample drillings had not been done at the Duckhawk Drive before, the soil sample numbers used for this example are hypothetical. In addition, we are also going to purposefully alter the foundation and drainage acceptability conditions to show how foundation cost is calculated. Users should note that Duckhawk Drive does not have foundation or drainage problems according to the field survey data.

If it is not already open, open the Road Data form of Duckhawk Dr. First, we are going to change the foundation and drainage acceptability conditions for a few segments of the road such that we can see how foundation cost is calculated. You should remember to change it back or discard the change after this exercise.

Foundation Cost
Change the Yes and No options of the Foundation and Drainage Acceptability columns according to Figure 43. You should see that the summary numbers for bad foundation and drainage not acceptable in Row 10 are both changed to 100 ft according to your change.

After clicking at the Estimation Cost button in Column K, you should notice that the Foundation Cost for improving the 100 ft of bad foundation and 100 ft of drainage upgrade is estimated at $220,000 (i.e., $200/ft * 100 ft for foundation + $2,000/ft * 100 ft for drainage).
Figure 43 Bad Foundation and No Drainage Acceptability Cost Calculation

Scroll to the right side of the form to the pavement design portion of the form (Figure 44). On top of the form, you should see yellow cells (i.e., highlighted in the blue square) that need to be entered before pavement cost can be calculated. These cells correspond to the upgrade pavement design options. Enter values to the design variables according to the values in Figure 44. Detailed explanation of these design variables can be found in the Methodology section of this user guide.
There are three other variables that must be entered before cost estimation can proceed: SP200, SSP200, and EP200, which are the weight percent of particles finer than the #200 sieve of the soil samples from the pavement Surface layer, Sub-Surface layer, and Embankment layer.

The pavement design method assumes that the P200 numbers at each sample location are applicable for the length of the road from the current location to the next sample location. That is, the P200 numbers 12%, 15%, and 70% at first 50 ft segment are applied in pavement design for 300 feet (See Figure 44). The second group 5%, 12%, and 20% at the distance 350 ft row is applied for remaining length (i.e., 537 ft) of the road.

You are now ready to calculate the upgrade cost according to the design options and soil sample P200 numbers you just specified. Before clicking at the Estimate Cost button on Column K, you need to make sure that the unit cost numbers are updated according to your specification. If you don't update the numbers, default values will be used.

Once you are ready, clicking at the Estimate Cost button will perform the calculation of pavement design and cost estimation. The result is shown in Figure 45. Technical details of all the resultant variables can be found in the Methodology section of this user guide.
Before completing this example, another important feature of the software is demonstrated here. It was mentioned previously that the software is designed to stop calculation at the row where the Road Width is left empty. The total upgrading cost reported by the software will be the total cost for the partial length (i.e., the segments with no road width entry will not be considered). This feature is for use in cases when only partial length of a road is being considered for upgrading. For example, if you want to estimate the upgrade cost for the first 300 ft of the Duckhawk Dr, just enter the segment width and other data up to 300 ft and leave rest of the cells empty. The data entry and the results should look like those shown in Figure 46. The total costs in Row 10 are the sums of only the first 300 ft.
Figure 46 Partial Length Pavement Design and Cost Estimation Results
Road Upgrade and Cost Estimation Methodology

The details of the pavement design methodology used by the software are documented in *Gravel Road Upgrade Pavement Design Module*, written by Robert L. McHattie of the AUTC research team and included as an appendix of the User Guide. This section explains how the method is implemented by the software, how the input variables are processed, and how the output variables are arranged. The Duckhawk Drive example is again used for illustration of the methodology. Figure 47 shows the design variables and soil sample p200 numbers used for this example.

![Figure 47 Duckhawk Drive Pavement Design Example](image)

**Figure 47 Duckhawk Drive Pavement Design Example**

**Determine Base Course and Standard Cover Fill**

We are using data from the first 300 feet of the road for illustration of the method. Users are encouraged to follow the example to check for the values for the remaining portion of the road.

For the first 300 ft of the road:

- \( P_{200} \) of surface material = 12%
- \( P_{200} \) of subsurface material = 20%
- $P_{200}$ of embankment = 70%

Determine standard cover fill requirements as shown in Figure 48:

- Surface material cover requirement = 14”
- Subsurface material cover requirement = 24”
- Embankment material cover material = 24”

![Figure 48 Standard Cover Fill Requirement Determination](image)

Because all three layers have standard cover fill requirements greater than 0, the standard cover fill requirement for the first 300 ft of the pavement is thus 24 inches, the maximum standard cover fill requirements of the three.

With the option of Add Base Course checked for Yes, the Base Course thickness in Column Q is set at 4’ for all segments, and the standard cover fill thickness is adjusted as:

$$24'' - 4'' \text{ (Base Course)} = 20''$$
Finally, the total thickness of the embankment is the road height + the added thickness of standard cover fill + added thickness of new base course. If the total thickness is greater than 24 inches, the standard cover fill thickness does not need to be increased. For our example, because the combined thickness of standard cover fill at 20” and base course at 4” is already at 24”, thus the standard cover fill for every 50 ft segment of the first 300 ft of the road is 20” (Column R).

**Base Course Cost**

The estimation of base course cost is simply the base course volume times the unit cost of base course materials. Figure 49 shows an illustration of the cross section of different pavement layers constructed on top of the existing road.

![Figure 49 Standard Cover Fill Diagram](image)

Base course volume is determined by the equation:

\[
\text{Base Course Volume} = \text{Segment Length} \times \text{Design Road Width} \times \text{Base Course Thickness (4'')}
\]

In our example, the design width is selected for 24 feet. For each 50 ft segment, the base course volume in cubic yards is 50 * 24 * (4/12) * (1/27) = 14.81 yd³.

With the unit cost of base course material at $50/ yd³, we have 14.81 * 50 = $741 base course cost (Column S) for every 50 ft segment.
Standard Cover Fill (SCF) Cost

The volume of standard cover fill of the new pavement structure includes the volume of the side slopes. The total volume of standard cover fill is illustrated with the shaded area in Figure 49. The volume of the standard cover fill layer is essentially the total volume of the new road structure (i.e., the large, outside trapzoid) minus the volume of existing road structure (i.e., the small, inside trapzoid). Because it is difficult to measure the side slopes on the existing road structure, we assume that all side slopes on existing roads are 1:2. Table 4 shows the calculation of SCF Cost for the first 300 feet of Duckhawk Drive.

Table 4 Standard Cover Fill Cost Calculation

<table>
<thead>
<tr>
<th>Segment Length (ft)</th>
<th>Existing Height (ft)</th>
<th>Existing Width (ft)</th>
<th>Existing Road Structure Volume (yd³)</th>
<th>Design Width (ft)</th>
<th>SCF Thickness (inch)</th>
<th>New Road Structure Volume (yd³)</th>
<th>SCF Volume (yd³)</th>
<th>SCF Cost ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>1</td>
<td>24.5</td>
<td>49</td>
<td>24</td>
<td>20</td>
<td>171</td>
<td>122</td>
<td>2931</td>
</tr>
<tr>
<td>50</td>
<td>1</td>
<td>23.5</td>
<td>47</td>
<td>24</td>
<td>20</td>
<td>171</td>
<td>124</td>
<td>2975</td>
</tr>
<tr>
<td>50</td>
<td>1</td>
<td>22</td>
<td>44</td>
<td>24</td>
<td>20</td>
<td>171</td>
<td>127</td>
<td>3042</td>
</tr>
<tr>
<td>50</td>
<td>1</td>
<td>23</td>
<td>46</td>
<td>24</td>
<td>20</td>
<td>171</td>
<td>125</td>
<td>2998</td>
</tr>
<tr>
<td>50</td>
<td>1.5</td>
<td>21</td>
<td>67</td>
<td>24</td>
<td>20</td>
<td>215</td>
<td>148</td>
<td>3560</td>
</tr>
</tbody>
</table>

Pavement Cost

The estimation of pavement cost is simply the pavement volume times the unit cost of pavement materials. Pavement volume is calculated with the following equation:

\[
Pavement\ Volume = Segment\ Length \times Pavement\ Width \times Pavement\ Thickness
\]

Pavement thickness depends on the pavement option selected. Table 5 shows the thickness specifications of the different pavement options.
Table 5 Pavement Options and Thickness

<table>
<thead>
<tr>
<th>Pavement Option</th>
<th>Thickness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hot Mix</td>
<td>2&quot;</td>
</tr>
<tr>
<td>Standard AST</td>
<td>0.75&quot;</td>
</tr>
<tr>
<td>High Float AST</td>
<td>0.75&quot;</td>
</tr>
<tr>
<td>Gravel</td>
<td>4&quot;</td>
</tr>
</tbody>
</table>

With the pavement width at 20 ft and option of Hot Mix, pavement volume for each 50 ft segment of the first 300 feet of Duckhawk Drive is $50 \times 20 \times \left(\frac{2}{12}\right) \times \left(\frac{1}{27}\right) = 6.2 \text{ yd}^3$. With a unit cost of $270/\text{yd}^3$ of Hot Mix asphalt concrete, the pavement cost per segment is $6.2 \times 270 = $1667$ (Column U).
Appendix: Gravel Roads Upgrade Pavement Design Module